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UNDERSTANDING TABLES 
 

A table lets you present information in a grid-like 
format. Consider a roster – it may show the days 
of the week across the top of the table, one day 
per column; list the employees down the left side 

of the table, one person per row; and show who is 
rostered on each day by the number of rostered 
hours in the cell beneath the relevant day. 

 
 

 

What is a Table? 
A table comprises one or more horizontal rows and one or more vertical columns. The rectangle 
where a row and column intersects is called a cell. Each cell can be filled with text, pictures or other 
objects. 

 

 
Inserting Tables 

Depending upon the type and style of table you require, there are several ways you can insert tables into 
a document. Access to each of these functions is via the Table tool which is found on the INSERT tab 
on the ribbon. If you want to quickly insert a formatted table into your document, you can choose from 
one of Microsoft Word’s Quick Tables, such as the example below, on the left. Quick Tables are tables 
that are preformatted with shading, column and row layout, and so on. They also contain sample 
information which you can use to help visualise the way your data will appear. After inserting a quick 
table, you can then replace the sample data with your own. You can also modify the table − such as 
deleting or inserting rows or columns − just like any other table. 
If you want to add a simple, unformatted table, you can drag to select the number of rows and columns 
that you require on the Insert Table grid. Alternatively, you can also insert a simple table, specifying the 
desired number of rows and columns, using the Insert Table dialog box. This method also lets you 
specify additional settings such as fixed column width and autofit. 
If you want to add a more complex table − for example, you may require a varying number of columns 
per row − you can quickly draw a table like the example on the right. 

 

 

Formatting Tables 
After inserting a table into your document, Word offers you many ways to format it. 
If you want to change the look of the entire table, you can use Table Styles. The advantage of using 
Table Styles is that as you hover over the various styles included in the gallery, Word uses Live 
Preview so you can see how the table will appear if you select the style. 
You can also format many other aspects of your table using the various tools on the Table Tools 
Design And Layout tabs. For example, you can apply shading and borders; specify headers and total 
rows; split and merge cells; insert and delete rows, columns and cells; alter the alignment within the 
cells; plus much, much more. 
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Try This Yourself: 

O
pe

n 
Fi

le
 

Before starting this 
exercise you MUST 
open the file Creating 
Tables_1.docx… 

1 Press  +  to 
move to the end of the 
document 

2 Click on the Insert tab 

3 Click on Table in the 
Tables group to open 
the Insert Table grid 
and drop menu 

4 Select Insert Table to 
open the Insert Table 
dialog box 

5 Type 3 in Number of 
columns 

6 Press  to move to 
Number of rows and 
type 5 
The Insert Table dialog 
box also gives you the 
opportunity to specify 
column width and to set 
your choices as the 
default values for future 
tables, but we won’t 
here... 

7 Click on [OK] to insert 
the table into your 
document 

 

 

For Your Reference… 
To create a simple table: 

1. Click on the Insert tab, click on Table in the 
Tables group 

2. Select Insert Table 
3. Type the Number of columns and rows, 

and specify other options as desired 
4. Click on [OK] 

Handy to Know… 
• You can insert a plain, unformatted table 

using the Insert Table grid. To do this, click 
on Table in the Tables group, then hover 
over the squares representing the number of 
columns and rows you need for your table 
(e.g. 5x4 Table). When you are happy with 
the size click to insert the table. 

CREATING A TABLE 
 

One of the simplest ways to create a plain, 
unformatted table is to use the Insert Table 
command. This command opens the Insert 
Table dialog box from which you can specify the 

number of columns and rows you require as well as 
the column width. When you use this command, 
Word will create a table with equally spaced 
columns and rows based on your settings. 
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Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Creating 
Tables_2.docx... 

1 Click in the top left cell 
of the table to ensure 
the insertion point is 
located at the start of 
the table, as shown 

2 Type Catalogue No, 
then press  to move 
to the next column 

3 Type Model, then press 
 to move to the next 

column 

4 Type Country, then 
press  to move to 
the first cell in the 
second row 

5 Repeat the above steps 
to complete the table as 
shown 

If you press  when 
you get to the end of the 
last row in the table, 
Word will automatically 
create a new row 

 

 

For Your Reference… 
To enter data into a table: 

Click in a table cell and type the desired text 
Press to move to the next cell 

Handy to Know… 
If you want to indent or align text within a 
cell, click to position the insertion point, then 
press + to move the text and 
insertion point to the next tab stop. If you 
press the insertion point will move to the 
next cell. 

ADDING DATA TO A TABLE 
 

Entering text or data into a table is a very simple 
process. You simply click in the cell and type. 
The text you enter into a table follows virtually the 
same rules as the text you type into other parts of 

the document. The text is based on a style and it 
can be formatted in the same way as normal text. It 
can also be aligned in the same way as a normal 
paragraph. 
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For Your Reference… 
To select in tables using the ribbon: 

1. Click in the cell, then click on the Table 
Tools: Layout tab 

2. Click on Select 
3. Click on the desired option to select the cell, 

column or row 

Handy to Know… 
You can use the keyboard to quickly and 
easily select table components. For example, 
to select a cell, position the cursor anywhere 
in a cell and press + + . 

SELECTING IN TABLES USING THE RIBBON 
 

After inserting a table and entering content, the 
next thing you’ll want to do is format the table. 
But before you can do this, you must first learn 
how to select the various table components. If 

you want to select standard components, such as a 
cell, column, row, or the entire table, you can 
quickly select these using the Select tool, which is 
found on the Table Tools: Layout tab. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the file 
Creating Tables_3.docx... 

1 In the table, click 
anywhere in the cell that 
contains the word Italy 
This is now the active 
cell. 

Notice that two additional 
tabs have appeared on 
the ribbon – the Table 
Tools: Design and the 
Table Tools: Layout tab… 

2 Click on the Table Tools: 
Layout tab, then click on 
Select in the Table group 
to display a menu of 
options 

3 Click on Select Cell to 
select the active cell 

4 Repeat steps 2 and 3 to 
click on Select Column 
to select the column 
containing the active cell 

5 Repeat steps 1 to 3 to 
click on Select Row to 
select the row containing 
the active cell 

6 Repeat steps 1 to 3 to 
click on Select Table to 
select the entire table 
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For Your Reference… 
To select in tables using the mouse: 

• Click just outside the table to the left of a row 
to select the row 

• Click just outside the table above a column 
to select the column 

• Click on the table move handle to select the 
entire table 

Handy to Know… 
• You can select text in a cell by double-

clicking on the first word and then dragging 
to the end of the cell. 

• To select a single cell, hover over the left 
border of the cell until the pointer appears as 
a small black right-pointing arrow, then click. 

SELECTING IN TABLES USING THE MOUSE 
 

You can only select standard table components 
using the ribbon, however using the mouse you 
can select all aspects of a table. For example, 
you can select text in a single cell, or in a 

contiguous or non-contiguous range of cells. You 
can also select a single cell, or contiguous and 
non-contiguous range of cells, rows and columns. 
And, of course, you can select the entire table. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or 
open the file Creating 
Tables_3.docx... 

1 Click on the word Electric, 
then drag to the right end of 
the cell to select both words 

2 Click anywhere in TEL00001, 
then drag down to 
COM00014 to select the text 
in the range of cells 

3 Double-click on Model, hold 
down , then double-click 
on both 1660 and Italy to 
select text in a non-
contiguous range 

4 Point outside the table to the 
left of TEL00015 so that the 
pointer changes to a white 
right-pointing arrow, then 
click and drag down to the 
next row to select both rows 

5 Point just above the top of 
the Model column so that the 
pointer changes to a black 
downwards-pointing arrow, 
then click to select the 
column 

6 Point to the top left corner of 
the table so that the table 
move handle appears and 
the cursor changes to a four-
headed arrow, then click 
once to select the entire table 
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Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the 
file Creating 
Tables_3.docx... 

1 Point to above the top 
of the border between 
the Model column and 
the Country column 
until the insert control 
appears as shown 

2 Click on the insert 
control to insert a new 
column 

3 Repeat steps 1 and 2 
to insert another new 
column as shown 

4 Enter the details, as 
shown, into the new 
columns 

Let’s create a new 
row... 

5 Point to the bottom left 
corner of the table 
until the insert control 
appears 

6 Click on the insert 
control to insert a new 
row 

7 Enter the details as 
shown in the new row 

 

 

For Your Reference… 
To insert a new column or row: 

1. Point to just above or to the left of two 
existing columns or rows 

2. When the insert control appears, click on it 

Handy to Know… 
• An alternative method for inserting a column 

is to split an existing column into two (or 
more). To do this, select the column, then 
click on Split Cells in the Merge group to 
open the Split Cells dialog box. To keep the 
entries in the selected cells, deselect Merge 
cells before split. 

INSERTING COLUMNS AND ROWS 
 

In an ideal world you would have correctly 
determined the numbers of rows and columns 
required before you created your table. But in the 
real world, you will often find that you 

underestimate the number of columns and/or rows 
you really need. Fortunately, Word makes it easy to 
insert new rows and columns into your table. 
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For Your Reference… 
To delete a row or column: 

1. Click on the desired table cell, then activate 
the Table Tools: Layout tab 

2. From the Rows & Columns group, click on 
Delete and select Delete Rows to delete a 
row, or select Delete Columns to delete a 
column 

Handy to Know… 
You can use Delete in the Rows & Columns 
group to delete a selected cell or entire table. 
You can delete all the content of a selected 
row or column without deleting the entire 
table by selecting the row or column and 
pressing . 

DELETING COLUMNS AND ROWS 
 

Occasionally you will find you need to delete 
columns or rows from your table − perhaps 
circumstances have changed and you no longer 
need the information. In Word, it is almost as 

easy to delete columns and rows from a table as it 
is to insert them. But just as a note, if the columns 
or rows to be deleted contain data, this data will be 
deleted along with the columns or rows. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the file 
Creating Tables_4.docx.... 

 The AGE Marketing 
Department has decided to 
remove the Country from 
the catalogue... 

1 Click on Country, then 
ensure the Table Tools: 
Layout tab is active 

2 Click on Delete in the 
Rows & Columns group 
to display a menu of 
options, then select Delete 
Columns 
The column and its 
contents will be deleted –
no questions asked. 
The Electric Document is 
no longer being produced 
so we must remove this 
product from the 
catalogue... 

3 Click on Electric 
Document 

4 Click on Delete in the 
Rows & Columns group, 
then select Delete Rows 
The row and its contents 
will be deleted and the 
rows below will move up to 
take its place 
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For Your Reference… 
To change a column’s width: 

1. Select the desired table column, then click 
on the Table Tools: Layout tab 

2. Click on the up or down spinner arrow for 
Width in the Cell Size group 

Handy to Know… 
• You can change the width of adjacent 

columns using the mouse. To do this, hover 
over the border between the columns until 
the pointer appears as a pair of vertical lines 
with a double-headed arrow, then drag left or 
right as desired. 

CHANGING COLUMN WIDTHS 
 

Once you start entering data into a table you may 
find some columns are not wide enough for the 
data while others are too wide. So to make the 
best use of available space and to make the table 

look as neat as possible, you may need to change 
column widths. This is easy to do using the Table 
Column Width tool on the ribbon. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the file 
Creating Tables_5.docx... 

1 Select the Catalogue No 
column, then ensure the 
Table Tools: Layout tab 
is active 

Currently the column is 
3.51 cm, as shown in 
Width in the Cell Size 
group... 

2 Click on the down spinner 
arrow for Width in the 
Cell Size group until the 
column’s width reduces to 
2.7 cm 

3 Repeat steps 1 and 2 to 
alter the widths of the 
remaining columns to the 
following 

Model 4 cm 
Category 3.8 cm 
Plant 3.2 cm 
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For Your Reference… 
To change a row’s height: 

1. Select the desired table row, then activate 
the Table Tools: Layout tab 

2. Click on the up or down spinner arrow for 
Height in the Cell Size group 

Handy to Know… 
• If you have specified different heights for 

different rows, a quick way to ensure that 
they all have the same height is to select 
them and click on Distribute Rows in the 
Cell Size group. 

CHANGING ROW HEIGHTS 
 

If you create a table on a new, blank document 
the text in the cells will appear with very little 
‘white space’ above and below them. By default, 
the text is aligned to the top left corner of the cell 

so if you increase the row height, you will increase 
the white space below the text. To even out this 
white space and ensure the table is aesthetically 
pleasing, you simply alter the cell alignment. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or open 
the file Creating 
Tables_6.docx... 

1 Select the Catalogue No row, 
then ensure that the Table 
Tools: Layout tab is active 

Currently the row is 
0.48 cm high, as shown in 
Height in the Cell Size group... 

2 Click on the up spinner arrow 
for Height in the Cell Size 
group until the row’s height 
increases to 
0.7 cm 

Let’s adjust the cell alignment 
to centre the text vertically 
within the cells... 

3 Click on Align Centre Left in 
the Alignment group 

4 Select the TEL00001 row, then 
hold down the mouse button 
and drag down until the 
remaining five rows are 
selected 

5 Repeat steps 2 and 3 to 
increase the height of the 
remaining rows to 0.6 cm and 
then centre the text vertically 
within the rows by clicking on 
Align Centre Left 
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For Your Reference… 
To AutoFit columns: 

1. Select the table, then click on AutoFit 
2. Select AutoFit Contents to reduce the 

column widths to fit the content, or 
Select Fixed Column Width to fix the 
column width, or 
Select AutoFit Window 

Handy to Know… 
• If a table is set to AutoFit Window and you 

insert a new column, the size of the existing 
columns in the table will reduce so that the 
final table width (with the new column) will 
still fit the window. 

AUTOFITTING COLUMNS 
 

By default, when you create a table using the 
Insert Table command, it will automatically fit the 
window and the column widths will be equal but 
not fixed – that is, their widths will change if you 

add or delete columns. Using the AutoFitting 
feature you can change a table so the column width 
remains fixed, or you can reduce all column widths 
so that they fit their largest entry. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or open 
the file Creating 
Tables_7.docx... 

1 Select the entire table, ensure 
the Table Tools: Layout tab 
is active, then click on AutoFit 
in the Cell Size group to 
display a menu of options 

2 Select AutoFit Contents 
The width of the columns will 
automatically reduce to fit... 

3 Click on AutoFit in the Cell 
Size group and select Fixed 
Column Width 
Nothing will appear to have 
happened. But let’s see what 
happens when you insert a 
new column... 

4 Select the Plant column and 
insert a column to the right 

The Table width will increase 
by the width of the new 
column (whose width will be 
identical to the Plant 
column)... 

5 Select the table again, then 
click on AutoFit in the Cell 
Size group and select AutoFit 
Window 
The width of each column will 
increase so that the table will 
be as wide as the window 
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Try This Yourself: 

Sa
m

e 
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Continue using the 
previous file with this 
exercise, or open the file 
Creating Tables_8.docx... 

1 Select the heading row of 
the table, then click on 
the Table Tools: Design 
tab 

2 Click on the drop arrow 
for Shading in the Table 
Styles group 

A gallery of available 
colours will appear... 

3 Click on Blue, Accent 1, 
Lighter 40% (4th row, 4th 

column) to apply the 
colour to the row 

4 Click outside the table so 
you can see the shading 
more clearly 

Let’s try an even quicker 
method… 

5 Click on Undo in the 
QAT then reselect the 
top row 

A mini toolbar will 
appear… 

6 Click on the drop arrow 
for Shading to display 
the colour gallery 

7 Repeat steps 3 to reapply 
the shading to the 
heading row 

 

 

For Your Reference… 
To apply shading to cells: 

1. Select the table cells 
2. Click on the Table Tools: Design tab 
3. Click on the drop arrow for Shading 
4. Click on the desired colour 

Handy to Know… 
• The shading gallery includes numerous 

shades of the selected theme colours plus 
ten standard colours. If you want to choose a 
different colour, click on More Colours, drag 
the marker around the larger Colours box 
plus the vertical colour ramp as desired, and 
then click on [OK]. 

SHADING CELLS 
 

Word allows you to apply shading to selected 
cells in a table. For instance, you may want to 
highlight cells containing important information. 
The shading can be any colour supported by 

your computer and Word. You apply shading to 
cells via the Shading tool on the Table Tools: 
Design tab on the ribbon or on the mini toolbar. 

 
 

 

 
 

 

 

 



LAB 17: ADDING TABLES 
 

MUSTANSIRIYAH UNIVERSITY \ COLLEGE OF DENTISTRY \ FIRST STAGE MUSTAFA H. ALI  

Pa
ge

 1
2 

Try This Yourself: 

Sa
m

e 
Fi
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Continue using the previous 
file with this exercise, or open 
the file Creating 
Tables_9.docx... 

1 Select the table, then click on 
the Table Tools: Design tab 

2 Click on the bottom half of 
Borders in the Borders group 
to display a gallery of options 
From here you can select 
what areas of the table the 
border will be applied to… 

3 Select No Border, then click 
outside the table to see the 
result 
Lets put an outside border 
around the table… 

4 Select the table and on the 
Table Tools: Design tab click 
on the bottom half of Border 
Styles in the Borders group 
to display a gallery of options 

5 Select a style 
For this exercise we have 
chosen Double solid lines, ½ 
pt, Accent 5… 

6 Click on the bottom half of 
Borders in the Borders group 
and select Outside Borders 

7 Click outside the table to see 
the result 

 

 

For Your Reference… 
To modify borders: 

1. Select the table and click on the Table 
Tools: Design tab 

2. Click on Border Styles in the Borders group 
and select a style 

3. Click on Borders in the Borders group and 
select a border type 

Handy to Know… 
• You can use Line Style in the Borders 

group to choose a style for your borders in 
the same way you would use Border Styles. 

MODIFYING BORDERS 
 

When you insert a table in Word, it appears with 
a border by default. This gives a matrix-like 
appearance to the table. You can change any or 
all of the lines in a table to suit your own tastes 

and to add more visual appeal to the table. For 
example, you could add a thicker outside border to 
give the table definition or you may even decide to 
have no borders at all. 
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For Your Reference… 
To add a custom border: 

1. Click on the Table Tools: Design tab 
2. Select a line style, line weight and pen 

colour 
3. Using the Border Painter, paint borders 

onto the table 

Handy to Know… 
To turn Border Painter off press or click 
on Border Painter in the Borders group. 
Border Painter turns on automatically if you 
use any of the tools in the Borders group. 
The only exception to this is if you use 
Borders. 

ADDING CUSTOM BORDERS 
 

You may want to apply a variety of border styles 
and colours to your table in order to highlight 
different areas of your table such as headings or 
important data. Using the Border Painter you 

can quickly and easily change specific parts of your 
borders. You can also change the appearance of 
borders using a variety of tools such as Pen 
Colour, Line Style and Line Weight. 

 
 

 
 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous file 

with this exercise, or open the file 
Creating Tables_10.docx... 

1 Select the table, then click on the 
Table Tools: Design tab 
Lets add a border to the inside of 
the table… 

2 Click on Line style in the Borders 
group to open a gallery of options 

3 Select the dotted line option, 
second from the top 

4 Click on Pen Colour in the 
Borders group and select Blue 
under Standard Colours 

5 Point to the table so the pointer 
changes to the paintbrush icon 

This means the Border Painter is 
active… 

6 Click in the middle of the line 
beneath Catalogue No then drag 
to the right to apply the border to 
the whole row 

7 Click outside the table to see the 
result 
This border is hard to see, lets 
make it thicker… 

8 Click inside the table, then click on 
Line Weight in the Borders group 
and select 1 ½ 

9 Repeat step 6 to apply this border 
to all inside row and column 
borders 
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Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the 
file Creating 
Tables_11.docx... 

1 Click in the table, then 
click on the Table 
Tools: Design tab 

2 Click on the More 
arrow in the Table 
Styles group, as 
shown, to open the 
Table Styles gallery 

3 Point to several 
options to see a Live 
Preview of the result 

4 Click on List Table 1 
Light – Accent 1 (this 
is a light blue style 
located near the top of 
the gallery) 

5 Click outside the table 
to deselect it and view 
the change 

 

 

For Your Reference… 
To apply a table style: 

1. Click in the table 
2. Click on the Table Tools: Design tab 
3. Click on the More arrow for Table Styles 
4. Select the desired style 

Handy to Know… 
• After you have applied a table style to a 

table, you can modify it as desired. To do 
this, click on the More arrow for Table 
Styles and select Modify Table Style. From 
the Modify Styles dialog box you can 
change all features including font, banding, 
paragraph spacing, borders, plus more. 

CHOOSING A TABLE STYLE 
 

Table styles provide you with a series of stylistic 
templates that can be applied to a table. These 
styles control the type and nature of the borders, 
colours, shading, banding, style of text, 

alignment, paragraph spacing, and the like. There 
are many styles from which you can choose and 
you can even customise the existing settings of a 
style to suit your own tastes. 
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For Your Reference… 
To create a table from text: 

1. Select the required text 
2. Click on the Insert tab, then click on Table in 

the Tables group 
3. Select Convert Text to Table 
4. Select the desired options and click on [OK] 

Handy to Know… 
• It is important to check that the Number of 

columns is correct in the Convert Text to 
Table dialog box. If the number in this field 
isn’t as required, you may have forgotten to 
insert a separator character in one or more 
lines of text. 

 

CREATING A TABLE FROM TEXT 
 

You can easily convert a list into a table. This is 
useful if you have rows and columns of text you 
would like to place into a table to make it easier 
to manage. By default when you convert text into 

a table, Word uses the paragraph marks to 
determine the number of rows and the tab marks to 
determine where text should be split into cells. 

 
 

 

Try This Yourself: 

O
pe

n 
Fi

le
 

Before starting this 
exercise you MUST open 
the file Table 
Features_1.docx… 

1 Select the data below the 
heading Paris Telephone 
Listing 

2 Click on the Insert tab, 
then click on Table in the 
Tables group to display a 
menu of options 

3 Select Convert Text to 
Table to open the 
Convert Text to Table 
dialog box 
Word has recognised that 
six columns are required, 
based on the number of 
tabs set in the text... 

4 Click on AutoFit to 
window under AutoFit 
behaviour and ensure 
Tabs is selected under 
Separate text at 
The text in this document 
is separated by Tab 
characters… 

5 Click on [OK] to convert 
the text into a table with 
borders applied 

 
 

 
 

  



LAB 17: ADDING TABLES 
 

MUSTANSIRIYAH UNIVERSITY \ COLLEGE OF DENTISTRY \ FIRST STAGE MUSTAFA H. ALI  

Pa
ge

 1
6 

For Your Reference… 
To change cell alignment: 

1. Select the cell(s) 
2. Click on the Table Tools: Layout tab 
3. Click on the desired alignment option in the 

Alignment group 

Handy to Know… 
• If a table has rows that are significantly 

higher than the text – perhaps you have 
manually increased the Table Row Height –
the content will appear neater if you use the 
three tools that centre the text vertically 
within the cell: Align Centre Left, Align 
Centre or Align Centre Right. 

ALIGNING DATA IN CELLS 
 

When you enter data into a table, the data will be 
left aligned in each cell by default. While this 
alignment usually works well, there are times 
when the table design could be improved if the 

cell alignment is changed. For example, if you have 
cells containing numbers of different lengths, they 
will appear neater if they are right aligned within the 
cell. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the 
file Table 
Features_2.docx... 

1 Select the top row of 
the table, then click on 
the Table Tools: 
Layout tab 

2 Click on Align Top 
Centre in the 
Alignment group to 
change the cell 
alignment to centre 
aligned 

3 Click to the left of the 
first salary 52,500, then 
hold down  and 
click to the right of the 
last salary 35,750 to 
select all salaries 

4 Click on the Table 
Tools: Layout tab, 
then click on Align Top 
Right in the Alignment 
group to change the cell 
alignment to right 
aligned 

5 Click outside the table 
to deselect the text and 
see the changes more 
clearly 
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Try This Yourself: 

O
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n 
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Before starting this 
exercise you MUST 
open the file Table 
Features_3.docx... 

1 Click in the table, then 
click on the Table 
Tools: Layout tab 

The gridlines show the 
columns, but as borders 
are applied to the rows, 
you will not see the row 
gridlines... 

2 Click on View Gridlines 
in the Table group to 
show the gridlines 

3 Click on View Gridlines 
in the Table group to 
hide the gridlines again 

Leave the document 
open for the next 
exercise 

 

 

For Your Reference… 
To display or hide gridlines: 

1. Click in the table 
2. Click on the Table Tools: Layout tab 
3. Click on View Gridlines in the Table group 

Handy to Know… 
• Gridlines do not appear if you view the 

document in Print Preview or in a web 
browser. 

DISPLAYING TABLE GRIDLINES 
 

Table gridlines are displayed by default in Word. 
Gridlines help you to identify the borders of each 
cell when entering and formatting data. Gridlines 
appear as dotted lines and do not print. If you 

have applied borders to your table you won’t see 
the gridlines, as they remain obscured by the 
borders. 
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For Your Reference… 
To insert a formula into a table: 

1. Click in the cell, then click on the Table 
Tools: Layout tab 

2. Click on Formula and type the Formula 
3. Select a Number format, then click on [OK] 

Handy to Know… 
• The Formula dialog box has a list of built-in 

functions − such as Average, Maximum 
and If − that you can paste into the Formula 
field. Using this feature will help to ensure 
that you type the formula correctly. 

• You can use the function PRODUCT(LEFT) 
to multiply values. 

INSERTING FORMULAS INTO A TABLE 
 

Word can conduct simple calculations in tables 
such as subtracting by using formulas. A formula 
is an instruction you can insert into a table that 
tells Word what data to calculate and how to 

calculate it. Word uses a function name to identify 
the calculation (such as SUM for addition), and the 
cells as references (such as cell C4) to determine 
the data to be calculated. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous file with 

this exercise, or open the file Table 
Features_3.docx... 

1 Ensure the gridlines are displayed, 
Click in the Line Total cell for the 
2500lt tank 

2 Click on the Table Tools: Layout tab, 
then click on Formula in the Data 
group to open the Formula dialog box 
Let’s change the formula so it 
multiplies the values... 

3 Select the value in Formula and type 
=C3*D3 
This tells Word to multiply cell C3 (3) 
by cell D3 ($890.00) where the column 
is given a letter from A-Z and the row 
is given a number from 1 onwards… 

4 Click on the drop arrow for Number 
format and select 
$#,##0.00;($#,##0.00) to format the 
result as currency 

5 Click on [OK] 

6 Repeat steps 1 to 5 to enter the 
following formulas: 

5000lt tank =C4*D4 
750lt tank =C5*D5 
600 pump =C7*D7 
45 pump =C8*D8 
800 pump =C9*D9 

7 Click in the empty Total cell, click on 
Formula, type =SUM(E3:E9), then 
click on [OK] 
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Try This Yourself: 

Sa
m

e 
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le
 

Continue using the previous 
file with this exercise, or 
open the file Table 
Features_4.docx... 

1 Triple-click on $1350.00 in 
Unit Price for the 5000lt 
tank to select the cell 
We mistyped the Unit Price 
for this tank... 

2 Type $1,390.50 and press 
 

Notice the Line Total has 
not updated – it is still 
$2,700.00. For the correct 
value to appear, the 
formulas need to be 
recalculated... 

3 Point to the top left corner of 
the table until the cursor 
changes to a four headed 
arrow, then click once to 
select the whole table 

4 Press  to perform a 
recalculation – every 
formula in the table will 
recalculate – then click 
outside the table to deselect 
it 
Notice that the Line Total for 
the 5000lt tank has 
increased to $2,781.00 and 
the Total at the bottom of 
the table has increased to 
$8,888.00 

 

 

For Your Reference… 
To update formulas: 

Make changes to the cell value(s) 
Select the table 
Press 

Handy to Know… 
• To update a formula once you’ve made 

changes to its dependent data, right-click on 
the formula and select Update Field. This 
will recalculate the cells and update the 
formula value. 

UPDATING FORMULAS IN A TABLE 
 

A significant drawback when using formulas in 
Word is that the formula does not update 
automatically if the data in one of the dependent 
cells changes. For example, if you change the 

quantity of an item, the line total for that item will 
not update automatically. You can, however, 
instruct Word to refresh all formulas in a table after 
changing any data. 
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Try This Yourself: 

Sa
m

e 
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Continue using the 
previous file with this 
exercise, or open the file 
Table Features_5.docx... 

1 Select the three rows 
below Round Tanks 

2 Click on the Table Tools: 
Layout tab, then click on 
Sort in the Data group, to 
open the Sort dialog box 

3 Ensure Column 1 is 
selected in Sort by, then 
click on the drop arrow for 
Type and select Number 

4 Ensure Ascending is 
selected, then click on 
[OK] to sort the three tank 
rows in ascending order of 
volume 

Let’s sort the Pump rows 
but this time the entries in 
the first column are 
textual... 

5 Select the three rows 
below Pumps, then repeat 
the steps 2 to 4 to sort the 
rows using the same 
settings in the dialog box 

6 Click outside of the table 
to deselect it 

 

 

For Your Reference… 
To sort table data: 

1. Select the cells containing the data to be 
sorted 

2. Click on the Table Tools: Layout tab, then 
click on Sort in the Data group 

3. Select the sort criteria, then click on [OK] 

Handy to Know… 
• To sort data in descending order select 

Descending in Sort by in the Sort dialog 
box. 

SORTING TABLE DATA 
 

The Sort function lets you sort data in a table. 
Data can be sorted alphabetically, numerically or 
by date, in either ascending or descending order. 
So whether you want to organise an address 

book or know at a glance which product is selling 
best, you can present the data in a table and then 
sort it. 
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Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
Table Features_6.docx... 

1 Click in the Description 
heading cell, then hold 
down  and click in the 
cell to the right, to select 
both cells 

2 Click on the Table Tools: 
Layout tab, then click on 
Merge Cells in the Merge 
group 

You can see the cells are 
merged as the dotted 
boundary has 
disappeared between the 
two cells… 

3 Repeat step 1 to select 
the four cells in the 
bottom row as shown 

4 Repeat step 2 to merge 
the four cells into one 

Because the word Total is 
right-aligned, it remains in 
the same position. If the 
word had been left-
aligned, it would have 
moved to the left of the 
merged cell 

 

 

For Your Reference… 
To merge cells: 

1. Select the cells to be merged 
2. Click on Table Tools: Layout tab, then click 

on Merge Cells in the Merge group 

Handy to Know… 
• To merge several cells into two or more cells 

(such as merging 8 cells into 4 cells), select 
the cells, click on Split Cells in the Merge 
group, to open the Split Cells dialog box, 
ensure that Merge cells before split is 
ticked, then enter the desired number of 
columns or rows. 

MERGING TABLE CELLS 
 

You can merge two or more cells in a table. 
When you merge cells, all selected cells will 
become a single cell. This is useful for headings 
that span across several columns, for example. 

To merge two or more cells, select the cells to 
merge and then apply the Merge Cells command 
to the selection. 
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Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file Table 
Features_7.docx... 

1 Click in the Description cell, 
then click on the Table Tools: 
Layout tab 

Let’s add a new heading 
between Description and 
Quantity – Description will 
need to be split into two cells... 

2 Click on Split Cells in the 
Merge group, to display the 
Split Cells dialog box 

3 Ensure 2 appears in Number 
of columns and 1 appears in 
number of rows, then click on 
[OK] to create two equal-sized 
cells 

Let’s now make the new 
heading cell the same width as 
the rest of the column… 

4 Point to the gridline between 
the two heading cells, until the 
pointer changes to , then 
hold down  and drag to the 
left until the gridline lines up 
with the column gridline 

5 Click in the new heading cell, 
then press  +  (bold) and 
type Details 

 

 

For Your Reference… 
To split cells in a table: 

1. Select the cell(s) to split 
2. Click on the Table Tools: Layout tab, then 

click on Split Cells in the Merge group 
3. Specify the number of columns and/or rows 

that you want to split the cell(s) into, then 
click on [OK] 

Handy to Know… 
• If you have multiple cells selected (for 

example 8 cells in one column), you can split 
them into numerous columns (e.g. 4) and 
merge them into a reduced number of rows 
(e.g. 2) simultaneously using the Split Cells 
dialog box. 

SPLITTING TABLE CELLS 
 

The Splitting Cells tool lets you select one or 
more cells and split them into several cells. This 
feature is particularly useful where you need 
more cells in a particular row. For example, if you 

have created a form, you might split two cells into 
six cells so that you can include several fields of 
data on the same row. 
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UNDERSTANDING TABLE PROPERTIES 
 

Tables offer much more flexibility than simply 
allowing you to create a grid of columns and 
rows. Many of the extra features you may require 
for your table can be found in the Table 

Properties dialog box. You can access this dialog 
box via the dialog box launcher for the Cell Size 
group on the Table Tools: Layout tab. 

 
 

 

 

      

      
 

 
 

1 Table Use the settings in the Table tab to specify how wide the table should be (Preferred 
width), its alignment on the page, how text should be wrapped around the table, how 
far the table should be indented from the left margin and borders and shading options. 
You can also set default cell margins and cell spacing via [Options]. 

2 Row Use the settings in the Row tab to specify how high one row, several rows, or all rows 
should be, whether a row should act as a header row, and whether the row can break 
across pages. 

3 Column Use the settings in the Column tab to specify how wide one column, several columns 
or all columns should be. 

4 Cell Use the settings in the Cell tab to specify how wide an individual cell should be and 
how the text within the cell should be vertically aligned (top, centre or bottom of the 
cell). You can click on [Options] to specify the default internal margins for an 
individual cell. 

5 Alt Text In the event that the table will be uploaded onto the web and visitors to the web page 
are waiting for the table to load or cannot see the table, you can insert alternative text 
that will be displayed in place of the table. Here you might enter the name or 
description of the table. 
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Try This Yourself: 
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 Continue using the 
previous file with this 
exercise, or open the 
file Table 
Features_8.docx... 

1 Click anywhere in the 
table to activate it 

2 Click on the Table 
Tools: Layout tab, 
then click on 
Properties in the Table 
group to open the 
Table Properties 
dialog box 

3 On the Table tab, click 
on Centre in 
Alignment, then click 
on [OK] to centre the 
table (horizontally) on 
the page 

 

 

 

For Your Reference… 
To align tables on the page: 

1. Click in the table 
2. Click on the Table Tools: Layout tab 
3. Click on Properties in the Table group 
4. Select an Alignment option 
5. Click on [OK] 

Handy to Know… 
• You can open the Table Properties dialog 

box by right-clicking on a table and selecting 
Table Properties, or by clicking on the 
dialog box launcher for the Cell Size group. 

ALIGNING TABLES 
 

You can align a table on a page, selecting to left-
align, centre-align or right-align the table. This is 
useful if the width of the table doesn’t extend 
across the page, or to improve the layout of your 

document. Word has several table alignment 
options available in the Table Properties dialog 
box. 
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For Your Reference… 
To change text direction in a table: 

1. Select the text to be rotated 
2. Click on the Table Tools: Layout tab, then 

click on Text Direction 

Handy to Know… 
• Rather than cycling through the text direction 

options by clicking repeatedly on Text 
Direction, you can also right-click on the cell 
and select Text Direction to display the Text 
Direction dialog box and then choose an 
option directly. 

CHANGING THE DIRECTION OF TEXT 
 

You can change the direction of text in tables so 
that it appears vertically rather than horizontally. 
Changing text direction is a useful feature for 
specialised tables such as price lists, reports, 

invoices, and the like. Click repeatedly on Text 
Direction on the Table Tools: Layout tab to cycle 
through some of the available styles and select the 
style you want. 

 
 

 

Try This Yourself: 

O
pe

n 
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le
 Before starting this exercise 

you MUST open the file 
Table Features_9.docx... 

1 Click in the first empty cell in 
the first column 

2 Type Round Tanks, then 
press  and type Pumps in 
the second empty cell 

3 Click on the Table Tools: 
Layout tab, then click on 
Text Direction in the 
Alignment group 

The text becomes vertical. 
Let’s keep clicking on Text 
Direction to cycle through 
some of the available 
styles… 

4 Click on Text Direction to 
apply the next style, Align 
Bottom Centre 

5 Select Align Bottom Left in 
the Alignment group, then 
repeat step 4 until Round 
Tanks is the same 
orientation 

6 Select both cells, click on the 
Table Tools: Layout tab, 
then click on Align Centre 
Left in the Alignment group, 
to centre the text along the 
left of the cell 

7 Deselect the text to view the 
result 
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For Your Reference… 
To insert a repeating header row: 

1. Click in the row that contains the headings 
2. Open the Table Tools: Layout tab 
3. Click on Repeat Header Rows in the Data 

group 

Handy to Know… 
• Note that the repeating header row feature 

will not work on a table that has been split 
over two pages with a manual page break. 
When inserting a page break between a 
table, Word recognises the tables as two 
separate tables. 

REPEATING HEADING ROWS 
If you have a table with many rows, such as a 
contact or product list, the table may extend 
across multiple pages. In this instance, when the 
user is looking at a section of the table that is not 

 
 

on the first page, it may be hard to navigate if the 
headings only appear at the top of the table. This 
can be resolved by repeating the header row at the 
top of each page. 

 
 

 

Try This Yourself: 

O
pe

n 
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 Before starting this exercise 

you MUST open the file 
Table Features_10.docx… 

1 Scroll through the document 
and notice the column 
headings appear only at the 
start of the table on the first 
page 

2 Return to the top of the 
document and click in the 
blue-grey heading row 

This row contains the 
column headings that we 
want to repeat on every 
page… 

3 Click on the Table Tools: 
Layout tab, then click on 
Repeat Header Rows in the 
Data group, to mark this row 
as the repeating row 

4 Scroll down to page 2 

The header row is now 
repeated at the top of the 
page… 

5 Click on the Next Page 
button to view the other 
pages 

The header row should 
appear at the top of each 
page, where the table 
occurs 
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For Your Reference… 
To convert a table to text: 

1. Click in the table, then click on the Table 
Tools: Layout tab 

2. Click on Convert to Text and select a 
separator 

3. Click on [OK] 

Handy to Know… 
• Although separating the text using tab marks 

produces a pleasing effect when converting a 
table to text, you can choose other separator 
characters. For example, if you want each 
cell entry to be converted to a new 
paragraph, click on Paragraph marks in the 
Convert Table To Text dialog box. 

CONVERTING A TABLE TO TEXT 
 

Word lets you convert tables to text. You can 
choose to convert the whole table or a range of 
contiguous rows anywhere within the table. You 
cannot convert selected cells. As part of the 

conversion, you can specify the separator 
character that will be used in place of the column 
boundaries, such as tabs or spaces, while each 
row will be separated with paragraph marks. 

 
 

 

Try This Yourself: 

O
pe

n 
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Before starting this 
exercise you MUST open 
the file Table 
Features_11.docx… 

1 Click anywhere in the 
table 

You will convert all data in 
the table to text… 

2 Click on the Table Tools: 
Layout tab, then click on 
Convert to Text in the 
Data group to open the 
Convert Table To Text 
dialog box 

3 Ensure Tabs is selected, 
click on [OK], then click in 
the heading to deselect 
the text 

The table will be 
converted to text, where 
each cell in a row is 
separated by a tab mark 
and each row has 
become a new 
paragraph… 

4 Click on the Home tab, 
then click on Show/Hide 
to display the tab and 
paragraph marks that 
have been inserted to 
separate the text in the 
conversion 
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